
LBNL-44789 
November 2001 

Program Description 

A PC Program 

WINDOW 5.0 User Manual 

For Analyzing Window Thermal Performance  
Windows & Daylighting Group 
Building Technologies Program 
Environmental Energy Technologies Department 
Lawrence Berkeley National Laboratory 
Berkeley, CA 94720  USA 
 
 Regents of the University of California 
This work was supported by the Assistant Secretary for Energy Efficiency and Renewable Energy, Office of Building Technology, State 
and Community Programs, Office of Building Research and Standards of the U.S. Department of Energy under Contract No. DE-AC03-
76SF00098.     

 
 

 
 



 



 
 

LBNL-44789 
November 2001 

 
 

WINDOW 5.0 User Manual 
 

Robin Mitchell, Christian Kohler, and Dariush Arasteh 
Windows and Daylighting Group 

Building Technologies Department 
Environmental Energy Technologies Division 

Lawrence Berkeley National Laboratory 
Berkeley, California  94720 

http://windows.lbl.gov/software/software.html 
 

Charlie Huizenga and Tiefeng Yu  
Center for Environmental Design Research 

University of California 
Berkeley, California 

 
Dragan Curcija 

Carli, Inc 
Amherst, Massachusetts  

 
 
 
 
 
 

November 2001 
 
 
 

 Regents of the University of California 
 

This work was supported by the Assistant Secretary for Energy Efficiency and 
Renewable Energy, Office of Building Technology, State and Community Programs, 
Office of Building Systems of the U.S. Department of Energy under Contract No. 
DE-AC03-76SF00098. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DISCLAIMER 
 
This document was prepared as an account of work sponsored by the United States 
Government. While this document is believed to contain correct information, neither 
the United States Government nor any agency thereof, nor The Regents of the 
University of California, nor any of their employees, makes any warranty, express or 
implied, or assumes any legal responsibility for the accuracy, completeness, or 
usefulness of any information, apparatus, product, or process disclosed, or represents 
that its use would not infringe privately owned rights. Reference herein to any 
specific commercial product, process, or service by its trade name, trademark, 
manufacturer, or otherwise, does not necessarily constitute or imply its endorsement, 
recommendation, or favoring by the United States Government or any agency 
thereof, or The Regents of the University of California. The views and opinions of 
authors expressed herein do not necessarily state or reflect those of the United States 
Government or any agency thereof, or The Regents of the University of California. 

 
 

Ernest Orlando Lawrence Berkeley National Laboratory  
is an equal opportunity employer. 

 



 

Contents 

1.  Introduction 1 
1.1.  Overview...........................................................................................................................................1 

2.  Quick Start 1 
2.1.  Main Screen (Window Library) ....................................................................................................1 
2.2.  Menu System....................................................................................................................................2 
2.3.  Toolbar ..............................................................................................................................................4 
2.4.  Construct a Window Product.........................................................................................................5 

2.4.1.  Select the Glazing System for the Window.............................................................5 
2.4.2.  Select the Frame for the Window..............................................................................6 
2.4.3.  Add Dividers to the Window.....................................................................................7 
2.4.4.  Calculation.....................................................................................................................8 
2.4.4.  Calculation.....................................................................................................................9 
2.4.5.  Results............................................................................................................................9 
2.4.6.  Temperature Map for Window ................................................................................10 

2.5.  Saving Projects...............................................................................................................................11 

3.  Installation 1 

3.1.  System Requirements......................................................................................................................1 
3.2.  Installation Procedures....................................................................................................................1 

3.2.1.  Before Installing WINDOW ......................................................................................1 
3.2.2.  Installing WINDOW ....................................................................................................1 

3.3.  Links to THERM and Optics Programs .......................................................................................8 
3.4.  Installation Problems .......................................................................................................................9 

3.4.1.  Not enough disk space.................................................................................................9 
3.4.2.  Previous Version Detected .........................................................................................9 

3.5.  Uninstalling WINDOW ................................................................................................................10 

4.  Program Description 1 

4.1.  Overview...........................................................................................................................................1 
4.2.  Libraries in General.........................................................................................................................2 

4.2.1.  List and Detail Views ..................................................................................................2 
4.2.2.  Selecting Records from Libraries ..............................................................................3 
4.2.3.  Moving Between Records in Detail View...............................................................5 
4.2.4.  Creating New Records.................................................................................................5 

4.3.  Window Library ...............................................................................................................................7 
4.3.  Window Library ...............................................................................................................................8 

4.3.1.  Window Library Detail View.....................................................................................8 
4.3.2.  Window Library List View.......................................................................................10 
4.3.3.  Select the Glazing System for the Window...........................................................11 
4.3.4.  Select the Frame for the Window............................................................................12 
4.3.5.  Add Dividers to the Window...................................................................................13 



 

4.3.6.  Calculate ......................................................................................................................14 
4.3.7.  Condensation Index (CI) Calculation .....................................................................15 
4.3.8.  Temperature Map .......................................................................................................16 

4.4.  Glazing System Library ................................................................................................................16 
4.4.  Glazing System Library ................................................................................................................17 

4.4.1.  Glazing System Library Detail View......................................................................17 
4.4.2.  Glazing System Library List View..........................................................................19 
4.4.3.  Create a New Glazing System..................................................................................20 

4.5.  Glass Library ..................................................................................................................................22 
4.5.1.  Glass Library Detail View........................................................................................22 
4.5.2.  Glass Library List View............................................................................................24 
4.5.3.  The Optics5 Connection............................................................................................25 
4.5.4.  Updating the Glass Library from Optics5..............................................................25 
4.5.5.  Creating a User-Defined Glass Layer.....................................................................27 

4.6.  Gas Library .....................................................................................................................................29 
4.6.1.  Gas Library Detail View...........................................................................................29 
4.6.2.  Gas Library List View...............................................................................................32 
4.6.3.  Gas Mixtures ...............................................................................................................33 

4.7.  Frame Library .................................................................................................................................34 
4.7.1.  Frame Library Detail View.......................................................................................34 
4.7.2.  Frame Library list View............................................................................................37 
4.7.3.  Importing THERM files ............................................................................................38 
4.7.4.  Condensation Index (CI) Calculation .....................................................................40 

4.8.  Divider Library ..............................................................................................................................41 
4.8.1.  Divider Library Detail View....................................................................................41 
4.8.2.  Divider Library List View ........................................................................................44 
4.8.3.  Importing THERM Files ...........................................................................................45 

4.9.  Environmental Conditions Library .............................................................................................46 
4.9.1.  Environmental Conditions Library Detail View...................................................46 
4.9.2.  Environmental Conditions Library List View.......................................................55 

 
 



WINDOW5 User Manual November 2001 1-1 

1.  Introduction 

1.1.  Overview 

WINDOW5 is a state-of-the-art, Microsoft WindowsTM-based computer program developed at Lawrence 
Berkeley National Laboratory (LBNL) for use by manufacturers, engineers, educators, students, architects, 
and others to determine the thermal and solar optical properties of glazing and window systems. 

 

WINDOW5, is a significant update to LBNL's WINDOW4.1 computer program and includes all of the 
WINDOW4.1 capabilities as well as: 

§ a state of the art MS-Windows interface 

§ updated algorithms consistent with ASHRAE SPC142 and ISO15099 

§ a Condensation Resistance Index in accordance with a draft version of NFRC 500. 

§ a surface temperature map 

§ an integrated database of properties 

§ links to other LBNL window analysis software: 

§ THERM 5, for calculating 2-D frame and edge effects 

§ RESFEN, for calculating the energy effects of windows in typical houses throughout the United 
States 

§ Optics5 for the optical properties of all coated and uncoated glazings, laminates, and applied 
films. 
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2.  Quick Start 

2.1.  Main Screen (Window Library) 
The WINDOW5 main screen (which is the "detail screen" of the Window Library) for defining a complete 
window product, shown below, has 4 main screen areas: 

§ Left hand column for buttons (such as Calc, List, Details) and other common tools 

§ Input values such as Name, Size, etc. 

§ Graphic representation of the window. This representation has the various elements (glazing 
systems, frames, and dividers) which can be selected for a particular window by clicking on the 
element (this is shown in the following figures).  

§ Results 

§ Feedback about currently selected window or window component. 

Figure 2-1. Main Screen (Window Library, Detail View). 
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2.2.  Menu System 
There are seven menus in the WINDOW program: 

File The File menu is used to open and save WINDOW databases. 
Edit The Edit menu is used to edit information in the input fields 

Libraries  The Libraries menu is used to move between the WINDOW libraries 
Record The Record menu is used to move between records in the WINDOW libraries, as well as 

calculate the results for active records 
Tools The Tools menu is used to activate other programs such as Optics5 and THERM5 

View The View menu is used to move between the list and detailed views in the library, as 
well as control the display of the toolbar and status bar 

Help The Help menu is used to view the program version number as well as the program 
Help. 

File 

The File menu is used to open, save, and print new WINDOW databases. The menu options are: 

§ New 

§ Open 

§ Save 

§ Save As 

§ Print 

§ Print Preview 

§ Print Setup 

§ Preferences 

§ Exit 

§ Last four databases 

Edit 

The Edit menu is used to control the editing of individual fields in a record, as well as the record itself. The 
menu options are: 

§ Undo 

§ Cut 

§ Copy 

§ Paste 

§ Delete Record 

§ Import 

Libraries 

The Libraries menu is used to access the libraries in the WINDOW program. The menu options are: 

§ Window 
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§ Glazing System 

§ Glass 

§ Gas 

§ Frame 

§ Divider 

§ Environmetnal Conditions 

Record 

The Record menu is used to move between the records in the currently open library. The menu options are: 

§ First Record 

§ Previous Record 

§ Next Record 

§ Last Record 

Tools 

The Tools menu is used to start other programs in the LBNL software suite. The menu options are: 

§ THERM 

§ Optics 

View 

The View menu is used to move between the List and Detailed views of the libraries, as well as control the 
toolbars for the program. The menu options are: 

§ List View 

§ Detailed View 

§ Toolbar 

§ Status Bar 

Help 

The Help menu is used to access the WINDOW help topics, as well as version information. The menu options 
are: 

§ Help Topics 

§ About W5 
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Figure 2-2. File Menu choices. 

 

 

2.3.  Toolbar 

The toolbar offers shortcut buttons for several common functions, including navigating between each of the 
libraries. The figure below shows the toolbar with labels for each button. 

Figure 2-3. Toolbar buttons. 
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2.4.  Construct a Window Product 

2.4.1.  Select the Glazing System for the Window 

To view the characteristics of the glazing system of the window, click on the glazing system component and 
the information is displayed in the lower right group box, as shown below. This information is from the 
Glazing System Library. 
 
To select a new glazing system for this window, click on the glazing system to be changed, and either use the 
pulldown list to see the names of all the records in the Glazing System Library, or click on the double arrow 
button, and another window will open which displays all the values from the Glazing System Library. 

Figure 2-4. Select a Glazing System for the window. 

Step 1: 
Single click on the glazing system 
to select it. The glazing system 
will be hashed, and the color will 
change, to indicate that it has 
been selected. 

Step 3: 
To change the selected Glazing 
System, either: 

§ Click on the pulldown list to 
see the names from the 
Glazing System Library 

Or 
§ Click on the double arrow 

button to open a window 
showing all the information 
from the Glazing System 
Library 

Step 2: 
The characteristics of the 
currently selected glazing 
system are displayed in the 
lower group box. 

Results show “?” 
because the Calc 
button has not been 
activated. 
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2.4.2.  Select the Frame for the Window 

To view the characteristics of the frame of the window, click on a frame component and the information is 
displayed in the lower right group box, as shown below. This information is from the Frame Library. 
 
To select a new frame for this window, click on the frame component to be changed, and either use the 
pulldown list to see the names of all the frames in the Frame Library, or click on the double arrow button, and 
another window will open which displays all the values from the Frame Library. 
 

Figure 2-5. Select a Frame for the window. 

 

. 

Step 1: 
Single click on a frame 
component to select it. 
The frame color will 
change to indicate that 
it has been selected. 

Step 2: 
The characteristics of 
the frame will be 
displayed in the lower  
right group box. 

Step 3: 
To change the selected 
Frame, either: 

§ Click on the 
pulldown list to see 
the names from the 
Frame Library  

Or 

§ Click on the double 
arrow button to 
open a window 
showing all the 
ifnormation from 
the Frame Library. 

Results show 
"?" because the 
Calc button has 
not been 
clicked. 
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2.4.3.  Add Dividers to the Window 

To add dividers to the window without dividers, click on the Divider button above the Results group box. 

Figure 2-6. Specify the number of dividers for the window. 

. 

Step 1: 
Click on the 
Dividers 
button. 

Step 2: 
The Divider Configuration dialog box will 
appear. Select the correct number for Horizontal 
and Vertical Dividers, and click the OK button. 
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Figure 2-7. Select a Divider for the window. 

Step 3: 
The appropriate number of 
dividers will be displayed in 
the window. 

Step 4: 
Single click on a divider 
component to select it. 

Step 5: 
To change the selected 
Divider, either: 

§ Click on the pulldown 
list to see the names 
from the Divider 
Library records  

Or 
§ Click on the double 

arrow button to open 
a window showing all 
the information from 
the Divider Library. 
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2.4.4.  Calculation 

WINDOW will calculate the total product properties for the current record when the Calc  button is clicked.  

Figure 2-8. Calculate the whole product properties. 

2.4.5.  Results 

WINDOW calculates the following values for the Total Window Results: 
U-value  Total Product U-value 

SHGC  Solar Heat Gain Coefficient. 
VT Visible Transmittance 

CI Condensation Index, calculated according to NFRC 500 Procedures (Draft). It is possible 
to see the intermediate values used for the CI calculation by pressing the Detail button, 
explained in detail in Chapter 4 of this manual. 

 

Click the Calc 
button and the 
program will 
calculate the Total 
Window Results. 
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2.4.6.  Temperature Map for Window 

 
Click on the Temperature Map  button in the Total Window Results  group box to display a temperature map 
of the window, as shown below. 

 
Figure 2-9. Click on the Temperature Map radio button to see the temperature map for the current window. 

Note the following (see also Section 4.3, "Window Library" and Section 4.7, "Frame Library") about the 
Temperature Map data: 

§ It is necessary to use THERM 5 Alpha in order to get the proper temperature data. Older versions of the 
program will not have the correct data. 

§ It is necessary to model the THERM profiles with the CI feature turned on (this is turned on when 
importing the glazing system, or can be turned on after the glazing system is imported in the 
Options/Preferences menu, Therm File Options tab).  

 

Temperature legend appears with the 
temperature map. 

Click on the Display 
Mode pulldown and 
select Temperature 
to see the 
temperature map. 

Click on the Image 
Control button to 
control the 
temperatures in 
the map. 
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2.5.  Saving Projects 
It is possible to save the results and associated data (for each library) into different WINDOW5 databases for 
different projects. 

For example, after having created the glazing systems, imported the THERM files into the Frame Library, and 
constructed the desired Windows in the Window Library, this set of data can be saved into a project database 
with a unique name. 

The File/Save As menu can be used to save the data currently in the working project database as a different 
name. The project database that is shipped with the WINDOW is called W5.mdb, but a database can be saved 
with any name. 
 

 

Figure 2-10. Use the File/Save menu to save the current data into a different project database 

The File/Open menu can be used to open a previously saved project database located in any directory, as 
shown below: 

 

Figure 2-11. Use the File/Save menu to save the current data into a different project database 
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3.  Installation 

3.1.  System Requirements 

WINDOW5 requires the following minimum computer requirements: 

§ Pentium class or better. 

§ At least 32 MB of random access memory (RAM). For optimal operation, 64 MB or more of RAM is 
preferrable. 

§ Microsoft Windows 98TM, Windows 2000TM, Windows METM, or Windows NTTM.  (The program WILL 
NOT run with Windows 3.1TM, Windows NT 3.51TM or Windows 98TM).  

§ Hard disk drive with at least 40 MB of available disk space 

§ Printer supported by Microsoft Windows (serial, parallel, or shared over a network). 

3.2.  Installation Procedures 

3.2.1.  Before Installing WINDOW 

Close all programs before installing WINDOW and uninstall and previous versions of the WINDOW 
program before starting the installation of this version. 

3.2.2.  Installing WINDOW 

Put the program installation CD in the appropriate drive. 

The installation program should automatically start when the CD is inserted, but if not,  browse to the CD 
with MS Windows Explorer and double click on: 

Window5FPRsetup.exe 

 

Figure 3-1. Run the setup.exe file on the WINDOW installation CD. 

Click on 
Window5FPRsetup.exe to 
install WINDOW5 
 
Click on  
THERM5alpha.exe 
To install THERM5 
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An Installshield Wizard window will appear saying that the installation program preparing the installation. 
Wait for this window to disappear, and then proceed to the next step. To cancel the installation, click in the 
Cancel button. 

 

Figure 3-2.  The InstallShield Wizard window. 

Another InstallShield window will appear. Wait until this window disappears, and then proceed to the next 
step. To cancel the installation, click in the Cancel button. 

 

Figure 3-3.  The Windows Installer window. 
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The WINDOW Welcome window will appear. Click the Next button to proceed, or cancel the installation by 
clicking on the Cancel button. 

 

Figure 3-4.  The Welcome window. 

The License Agreement window will appear. After reading and agreeing to the terms of the license, click on 
Yes button to proceed with the installation. Click the Back button to go to the previous screen, or cancel the 
installation by clicking on the No button. 

 

Figure 3-5.  The License Agreement window. 
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The Customer Information  window will appear. Type the appropriate information into the fields, and click 
the Next button to proceed, or cancel the installation by clicking on the Cancel button. 

 

Figure 3-6.  The Customer Informaiton window. 

The Choose Destination Folder window will appear. The default folder for the program is C:\Program 
Files\LBNL\WINDOW5. NOTE: It is important to keep this directory structure in order for the WINDOW5 
installation to be compatible with the Optics5 installation. Extreme caution is advised if this structure is 
changed. Click the Next button to proceed. Cancel the installation by clicking on the Cancel button. 

 

Figure 3-7. The WINDOW Destination Folder window. 
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The installation program will display all the setting specified in the previous steps in the Start Copying Files 
window. Any of these settings can be changed by clicking on the Back button, or they can be accepted by 
clicking the Next button. The installation can be cancelled by clicking on the Cancel button. 

 

Figure 3-8.  The selected installation settings are displayed in the Start Copying Files window. 
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The installation program will install WINDOW, and show a bar with the completion status in the Setup 
Status window. The installation can be cancelled by clicking on the Cancel button. 

 

Figure 3-9.  WINDOW is being installed. 

When the installation is complete, the Installation Wizard Complete  window will appear. Click on the 
Finish button to finalize the installation.  

 

Figure 3-10.  Click on the Finish button to complete the installation. 

The program can be started from the Start button, Programs, LBNL Software, WINDOW5 FPR, as shown 
below. 
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Figure 3-11.  Start the program from the Start button. 
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3.3.  Links to THERM and Optics Programs 
In order to be able to use the THERM button in the Frame and Divider Libraries detail view (which launches 
the THERM program), and the Edit Glazing button in the Glass Library detail view (which launches Optics), 
it is necessary to have the THERM5alpha and Optics5 programs installed on your computer. 

If you already have these programs installed on your machine, you do not have to do this step. 

These two programs can be installed from the following sources: 

§ WINDOW5 Beta2 CD contains an installation file for the THERM5 Alpha version, called 
THERM5alphaSetup.exe, which can be run by double clicking on them from the Microsoft Windows 
Explorer. 

§ Optics can be downloaded from http://windows.lbl.gov/materials/optics5/default.htm. 

WINDOW5 will assume that the THERM and Optics5 programs are installed in the following default 
directories: 

§ For THERM 5: 

C:\Program Files\LBNL\THERM5alpha\Therm5alpha.exe 

§ For Optics5: 

C:\Program Files\LBNL\Optics5\Optics5.exe 

If these programs are not installed in these directories, when you click on the buttons that fire up the 
programs, WINDOW5 will put up a message saying that it can't find the programs, and an Open dialog box 
will appear, where you can browse to the program location. WINDOW5 will remember the location you 
specify, so you will only have to do this once. 

Figure 3-12.  WINDOW5 will ask for the Optics5 and THERM program locations if those programs are notinstalled in their default 
directories. 

If the Optics (or THERM) programs are not
installed in their default installation directories,
WINDOW5 will display a message saying it
can't find the program, and will display an
Open Window so that you can browse the
program location.
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3.4.  Installation Problems 

3.4.1.  Not enough disk space 

If the installation program detects that there is not enough disk space, a screen showing how much is needed 
will appear. 

 

Figure 3-13.  Window showing necessary disk space for WINDOW installation 

3.4.2.  Previous Version Detected 

The installation will detect if WINDOW has been previously installed and will require that it be uninstalled 
before the new installation can proceed (see Section 3.4, "Uninstalling WINDOW"). 

 

Figure 3-14.  Remove the previous version before installing a newer version. 
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3.5.  Uninstalling WINDOW 
To uninstall WINDOW, either run the original installation setup.exe which will display the Program 
Maintenance window (Figure 3 -18) and click on the Remove option, or open the Microsoft WindowsTM 
Control Panel. 

 

Figure 3-15. To uninstall WINDOW, run Control Panel 

Click on the Add/Remove Programs icon in the Microsoft WindowsTM Control Panel. 

 

Figure 3-16. Click on the Add/Remove Programs icon. 

In the Add/Remove Programs Properties dialog box, under the Install/Uninstall tab, select the WINDOW 5 
Beta 1  program, and click the Add/Remove  button. 
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Figure 3-17. Select the WINDOW 5 Beta 1 program and click the Add/Remove button 

The Welcome window will appear. Click the Remove  radio button, and then the Next button to proceed, or 
click the Back button to go back to the previous step. To cancel the program removal click on the Cancel 
button. 

 

Figure 3-18.  Click on the Remove radio button, and then click on the Next button. 

The Confirm File Deletion window will appear to verify that you want to remove the program. Click the OK  
button to remove the program, or click the Cancel button to cancel the program removal. 

 

Figure 3-19.  Click on the OK button to confirm the removal of the program. 
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The Setup Status  window will appear to show the progress of the program removal. To cancel the program 
removal click on the Cancel button. 

 

Figure 3-20. The progress of the program removal is displayed in the Uninstalling WINDOW 5 Beta 1 window. 

When the removal is complete the InstallShield Wizard Completed window will appear. Click the Finish 
button to complete the procedure. 

 

Figure 3-21. Click the Finish button to complete the program removal. 
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4.  Program Description 

4.1.  Overview 
WINDOW consists of a series of the following libraries which are described in detail in this chapter: 

§ Window Library 

§ Glazing System Library 

§ Glass Library 

§ Gas Library 

§ Frame Library 

§ Divider Library 

§ Environmental Conditions Library 
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4.2.  Libraries in General 
Libraries are the main components of the WINDOW5 program, and each library contains characteristics 
necessary for the calculations.  

4.2.1.  List and Detail Views 

There is a “List” and a “Detail” view of the data in each library. The List View shows all the records (rows) in 
the library but only some of the fields (columns with data), and the Detail View shows all the data (or fields) 
for one record. Most changes to the library records are made in the Detail View. 
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Figure 4-1. Switching between the List View and Detail View in a Library. 

4.2.2.  Selecting Records from Libraries 

From many of the libraries, it is necessary to select records from other libraries. For example, in the Window 
Detail View, in order to define a window, it is necessary to select records from the Frame Library, the Glazing 
System Library, and possibly the Divider Library. From the Glazing System Library, it is necessary to select 
records from the Glass Library and the Gas Library. 

The List View of the Frame Library 

The Detailed View of the Frame Library for the selected 
record, #14. 

Click on the List button to see the 
List View of the library 

Alternatively, double click on the 
highlighted record to go to the 
Detailed View. 

Click on the Detailed View button to see 
the Detail View of the selected record, 
where the values can be edited. 
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There are several different options for selecting records from other libraries, as discussed below.  

One method is to click on the double arrow icon where it appears. This will open a small dialog box with a 
listing showing all the records and their associated fields from that library. 

Figure 4-2. Selecting a record from another library. 

The double 
arrow select 
button can be 
used to open 
a view into 
the Glass 
Library to 
select glass 
layers. 
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4.2.3.  Moving Between Records in Detail View 

There are several ways to move between records in the Library Detail View: 

§ The Record Menu  contains choices for First Record, Previous Record, Next Record, Last Record 

§ The Toolbar has buttons for first , previous , next , and last  record to move between 
records. 

4.2.4.  Creating New Records 

New records are created in the List View of any of the libraries. From the List View, there are two methods 
for creating new records, either: 

§ Use the Copy  button to copy an existing record and change the data that is different for the new record. 

§ Use the New button to create a new record, based on a default record that is automatically included in 
the program for each library. 

Creating New Records Using New Button 

New records can be created in the List View using the New button, which will make a new record based on 
the values in the WINDOW default record for that Library. Go to the Detailed View of the new record and 
make the desired changes to the input values. 

Figure 4-3. Create a new record using the New button. 

 

Step 3: 
WINDOW5 will automatically assign a unique ID for the new record. A different ID 
number can be typed, as long as it is unique. Click OK to add the new record. 

Step 1: 
Click on the 
New button 
to copy the 
highlighted 
record. 
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Creating New Records Using Copy Button 

New records can be created in all the libraries by copying an existing record (by highlighting it and clicking 
on the Copy button in the List View) and then editing the new record with the desired values in the Detailed 
View. 

Figure 4-4. Create a new record by copying an existing record. 

Step 1: 
Click on the 
record to 
copy to 
highlight it. 

Step 3: 
WINDOW5 will automatically assign a unique ID for the new record. A different ID 
number can be typed, as long as it is unique. Click OK to add the new record. 

Step 2: 
Click on the 
Copy button 
to copy the 
highlighted 
record. 
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Figure 4-5. Edit the newly created record in the Library Detail View. 

Step 4: 
Highlight the record to be edited, then either click on the Detailed View button to make 
changes to the new record, or double click on the highlighted record. 

Step 5: 
Click on the Detailed View button to edit the values of the newly created record. 
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4.3.  Window Library 
The Window Library is where the whole product is constructed from each of the components (frames, glazing 
systems, dividers, environmental conditions). The calculation results will be for the entire product. 

4.3.1.  Window Library Detail View 

The Detail View shows details of individual windows in the Window Library. The upper left section of the 
screen is used to input the window characteristics. The upper right section of the screen shows a graphic 
representation of the window based on the input values. It is possible to see the selected components for 
frames, glazing systems, and dividers by clicking on the specific graphic elements; this will cause information 
about that element to appear in the lower right corner. The lower left section of the screen shows the 
calculation results for the whole product. These results become "?" when any of the input values change, and 
can be recalculated by clicking in the Calc button. To define the number of dividers in a window, click on the 
Dividers button, and input the correct number of horizontal and vertical dividers. 
 

 

Figure 4-6.  Window Library, Detail View. 

The following section describes the input and results fields in the Window Library Detail Screen. 
ID The unique ID associated with each window record. This value is automatically 

assigned when a new record is created in List View, and can be changed at that time by 
the user as long as the value is unique. 

Name  The name of the glass layer. If the record was imported from the Optics5 database, this 
name will automatically come from that database. 
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#Layers  The number of layers for the glazing system. The layers are increased or decreased using 
the up and down arrows to the right of this field. The program will automatically adjust 
the number of layers in the layers detail section of the screen based on this number 

Tilt The tilt of the glazing system. Default:  90o 

Environmental 
Conditions The name of the appropriate environmental condition from the Environmental 

Condition Library, selected using the arrow to the right of the field. Default:  
ASHRAE/NFRC. 

ID# The unique ID associated with each glazing system record.  

Name  The name of the window, defined by the user. 
Mode The Mode of the calculation. Default:  NFRC 

Type The Type of window product, from the pulldown list. The Type determines the display 
to the right and the number of lites and frame sections available for definition. 

Tilt Tilt of the product. Default: 90 
Size Overall size of the product, based on the Type input value.  

Width Overall width of the product, based on the Type input value. Units: mm (SI); inches (IP). 

Height Overall height of the product, based on the Type input value. Units: mm (SI); inches (IP) 
Area Overall area of the product, based on the Height and Width. Units: mm (SI); inches (IP). 

Environmental  
Conditions Environmental conditions to be applied to the whole product calculations. The 

pulldown list shows the records in the Environmental Conditions Library. 

 

Total Window Results  
U-factor  The whole product U-factor.  
SHGC  The whole product Solar Heat Gain Coefficient. 

VT The whole product Visible Transmission. 
CI The whole product Condensation Index. 

Detail This button displays detailed values for the Condensation Index calculation. 
 

Display Modes 
Normal Normal display of the product, showing the geometry 

Temperature 
Map Temperature map display of the product. This will only be displayed if the frame cross 

sections were calculated with THERM 5. 
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4.3.2.  Window Library List View 

The List View shows all the records in the Window Library.  
 

 

Figure 4-7. Window Library, List View. 

The buttons on the left hand side of the List View have the following functions: 

Detailed View goes to the detailed view of the record, where the input values can be edited. 
New Used to make a new record, based on a default record. 

Copy Used to copy an existing record (including name and all associated input values) into a 
new record. 

Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 
Import  Currently disabled. 

Export Used to create a comma-separated text file of the Window Library list.  
Report Used to create one of the following reports: 

§ Window 4.1:  a report in the same format as Window 4.1, with all the data associated 
with the window. 

§ DOE-2:  a report (text file) that contains input data to be used with the DOE-2 hourly 
simulation program. Currently, this file can only be written for windows with one 
light 

 

Print Used to print a report which contains a list of all the records in the library. 
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4.3.3.  Select the Glazing System for the Window 

To view the characteristics of the glazing system of the window, click on the glazing system component and 
the information is displayed in the lower right group box, as shown below. This information is from the 
Glazing System Library. 
 
To select a new glazing system for this window, click on the glazing system to be changed, and either use the 
pulldown list to see the names of all the records in the Glazing System Library, or click on the double arrow 
button, and another window will open which displays all the values from the Glazing System Library. 

Figure 4-8. Select a Glazing System for the window. 

Step 1: 
Single click on the glazing system 
to select it. The glazing system 
will be hashed, and the color will 
change, to indicate that it has 
been selected. 

Step 3: 
To change the selected Glazing 
System, either: 

§ Click on the pulldown list to 
see the names from the 
Glazing System Library 

Or 
§ Click on the double arrow 

button to open a window 
showing all the information 
from the Glazing System 
Library 

Step 2: 
The characteristics of the 
currently selected glazing 
system are displayed in the 
lower group box. 

Results show “?” 
because the Calc 
button has not been 
activated. 
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4.3.4.  Select the Frame for the Window 

To view the characteristics of the frame of the window, click on a frame component and the information is 
displayed in the lower right group box, as shown below. This information is from the Frame Library. 
 
To select a new frame for this window, click on the frame component to be changed, and either use the 
pulldown list to see the names of all the frames in the Frame Library, or click on the double arrow button, and 
another window will open which displays all the values from the Frame Library. 
 

Figure 4-9. Select a Frame for the window. 

 

Step 1: 
Single click on a frame 
component to select it. 
The frame color will 
change to indicate that 
it has been selected. 

Step 2: 
The characteristics of 
the frame will be 
displayed in the lower  
right group box. 

Step 3: 
To change the selected 
Frame, either: 

§ Click on the 
pulldown list to see 
the names from the 
Frame Library  

Or 

§ Click on the double 
arrow button to 
open a window 
showing all the 
ifnormation from 
the Frame Library. 

Results show 
"?" because the 
Calc button has 
not been 
clicked. 
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4.3.5.  Add Dividers to the Window 

To add dividers to the window without dividers, click on the Divider button above the Results group box. 

Figure 4-10. Specify the number of dividers for the window. 

Step 1: 
Click on the 
Dividers 
button. 

Step 2: 
The Divider Configuration dialog box will 
appear. Select the correct number for Horizontal 
and Vertical Dividers, and click the OK button. 
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Figure 4-11. Select a Divider for the window. 

4.3.6.  Calculate 

When all the components for the product have been defined, the total product values can be calculated by 
clicking on the Calc button. 

Step 3: 
The appropriate number of 
dividers will be displayed in 
the window. 

Step 4: 
Single click on a divider 
component to select it. 

Step 5: 
To change the selected 
Divider, either: 

§ Click on the pulldown 
list to see the names 
from the Divider 
Library records  

Or 
§ Click on the double 

arrow button to open 
a window showing all 
the information from 
the Divider Library. 
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4.3.7.  Condensation Index (CI) Calculation 

WINDOW5 includes a feature which calculates the whole product Condensation Index (CI) using the 
methodology presented in NFRC 500.  This process involves importing files from THERM5 into the Frame 
and Divider library that have been modeled in THERM with the Condensation Index feature. See the 
THERM5 User’s Manual and the NFRC THERM5 / WINDOW5 Simulation Manual for the specifics of 
modeling these THERM files. The modeling procedures for CI are slightly different from those for U-factor, 
and will mostly likely mean that different THERM files must be created for the CI and U-factor calculations. 
This will also mean that in WINDOW, separate  

surface temperatures from THERM for each cross-section (see Section 4.7.4, "Condensation Index 
Calculations"); surface temperatures are then area weighted in accordance with NFRC 500 which considers 
the areas covered with condensation at three different relative humidities.  The resulting total product CI 
value is presented on the Total Window Results section of the Window Library Detailed View. The Detail 
button to the right of the CI rating on the Window Library Detail View shows intermediate component 
specific values used in the CI calculation. 

 

Figure 4-12.  Condensation Index results for the whole window product. 

The whole 
product 
Condensation 
Index value is 
presented in the 
CI box. 

The Detail button shows CI results 
from all the window components that 
are used to calculate the whole 
produce CI value. 
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4.3.8.  Temperature Map 

WINDOW5 displays a Temperature Map for the whole product, based on detailed temperature from 
THERM. Therefore, this feature requires that the frame components of the whole product are referencing 
THERM 5.0 Alpha files (modeled with the Condensation Index feature turned on). 

Figure 4-13.  The Temperature Map. 

Click on the Image 
Control button to control 
the Temperature Map 
image settings  

Normal Display Mode Temperature Map Display Mode 

Click on Display Mode 
pulldown and select 
Temperature to display 
the Temperature Map 

Click on Display Mode 
pulldown and select 
Normal to return to the 
the normal display 
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4.4.  Glazing System Library 
The Glazing System Library is used to construct glazing systems to determine the center of glass U-factor, 
which can be used in the Window library to construct a whole product. Glazing Systems consist of glass 
layers selected from the Glass Library (which are from the Optics5 database) and definitions of the gaps 
between the glass layers, which are defined by a thickness and selections from the Gas Library. When the 
glass layers and gaps have been defined, the results are calculated using the Calc button. 

4.4.1.  Glazing System Library Detail View 

The Detail View shows details of individual glazing systems in the Glazing System Library. 
 

 

Figure 4-14. Glazing System Library, Detail View. 

The following section describes the input fields for the overall glazing system. 
ID The unique ID associated with each glazing system record.  

Name  The name of the glass layer. If the record was imported from the Optics5 database, this 
name will automatically come from that database. 

#Layers  The number of layers for the glazing system. The layers are increased or decreased using 
the up and down arrows to the right of this field. The program will automatically adjust 
the number of layers in the layers detail section of the screen based on this number 

Tilt The tilt of the glazing system. Default:  90o 

Environmental 
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Conditions The name of the appropriate environmental condition from the Environmental 
Condition Library, selected using the arrow to the right of the field. Default:  
ASHRAE/NFRC. 

Comment A user entered comment. 
Overall  
Thickness The overall thickness of the glazing system. Units: mm (SI); inches (IP). 

The following section describes the input fields for the layers in the glazing system. 
ID The unique ID associated with each glazing system record.  

Name  The name of the glass layer. If the record was imported from the Optics5 database, this 
name will automatically come from that database. 

Mode An identifier to determine the glass layer approval status.  At this time, the only 
approval mode implemented is NFRC, indicated by “#”, and only records with “#” in 
this field can be used for NFRC simulations. 

Thick  Thickness Glass thickness. Units: mm (SI); inches (IP). 
Flip A checkbox to indicate whether or not the glass layer is flipped. Click the box to put an 

‘x’ in it, which indicates that the layer is flipped. This will cause the values for 
emissivities on the 1 and 2 surfaces to be interchanged. 

Tsol Solar transmittance of the glazing layer. 
Rsol1 Solar reflectance of the glazing layer, exterior-facing side. 

Rsol2 Solar reflectance of the glazing layer, interior-facing side. 

Tvis Visible transmittance of the glazing layer. 
Rvis1 Visible reflectance of the glazing layer, exterior-facing side. 

Rvis2 Visible reflectance of the glazing layer, interior-facing side. 
Tir Thermal infrared (longwave) transmittance of the glazing layer. 

E1 Infrared (longwave) emittance of the glazing layer, exterior-facing side 
E2 Infrared (longwave) emittance of the glazing layer, interior-facing side 

Cond Conductance of glass. Units: W/m-K (SI); Btu/h-ft-oF (IP) 
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4.4.2.  Glazing System Library List View 

The List View shows all the records in the Glazing System Library and some of the characteristics of the 
glazing system from the Detailed View. 

The list can be sorted by any column by double clicking on the desired column. 
 

 

Figure 4-15. Glazing System Library, List View. 

The buttons on the left hand side of the List View have the following functions: 
Detailed View Used to access the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. 
Copy Used to copy an existing record (including name and all associated input values) into a 

new record. 
Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 

Import  Currently disabled. 
Export Used to create a Window 4.1 file of glazing system records, called glzsys.w4. This file 

can then be imported into THERM or Window 4.1.  
Report Currently disabled. 

Print Used to print a report which contains a list of all the records in the library. 
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4.4.3.  Create a New Glazing System 

To create a new glazing system using the Copy button, follow these steps: 

§ In the Glazing System Library List View, copy an existing record by highlighting the record to be copied 
and clicking on the Copy button. 

§ Click on the Detailed View button to edit the glazing system information as needed, including the Name. 

§ Save the record using the Record/Save  menu (or Alt-S). 

Figure 4-16. Use the  button to copy an existing record to a new record. 

Figure 4-17. Highlight the newly copied record and click on the Detailed View button. 

Step 1: 
Highlight the 
record to be 
copied by 
clicking on the 
record. 

Step 3: 
WINDOW5 will automatically 
assign a unique ID for the new 
Glazing system. A different ID 
number can be typed, as long as 
it is unique. Click OK to add the 
new record. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record. 

Step 4: 
Make sure the new record is highlighted, then either click 
on the Detailed View button to make changes to the new 
record, or double click on the highlighted record. 

Step 5: 
Click on the 
Detailed View 
button to copy 
the highlighted 
record. 
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Figure 4-18. Editing the Glazing System characteristics in the Detailed View. 

The copied record after changes have been made. 

When the 
Detailed View is 
first opened, all 
the fields will be 
identical to the 
copied record. 

Click on the Select 
arrows to pick a 
new glass layer 
from the Glass 
Library. 

The results fields 
will become “?” 
when values 
change. Click on the 
Calc button to 
recalculate the 
results. 

The Select screen 
displays the 
records from the 
Glass Library. 

Click on the column 
names to sort by that 
column. 

Type a value in the 
Find box (and 
select either ID or 
Name from the 
pulldown list) to go 
to a specific record.

Highlight the desired 
glass library record, 
then click on the Select 
button to use it in the 
glazing system. 

The copied record before changes have been made. 

Use the 
up/down 
arrows to add 
or delete glass 
layers. 

Type a new name 
for the glazing 
system. 



4.5.  Glass Library 4.  Program Description 

4-22 November 2001 WINDOW5 User Manual 

4.5.  Glass Library 
The Glass Library contains the thermal and optical properties of glazing materials. The total solar, visible, and 
thermal infrared optical properties of a glazing as well as the thickness and thermal conductivity are 
displayed. The WINDOW5 Glass Library is linked to the Optics5 glass database, and is shipped with the most 
current Optics5 database, as discussed in Section 4.5.3, "The Optics5 Connection". 

4.5.1.  Glass Library Detail View 

The Detail View shows details of individual glass layers in the Glass Library  

 

Figure 4-19. Glass Library, DetailView. 

The optical properties defined for each glass entry are listed below: 
ID The unique ID associated with this record. For records whose Source is “Optics”, this ID 

is assigned by the Optics5 database. For records whose Source is “User”, this ID is 
assigned automatically by WINDOW but can be overwritten by the user as long as it is 
unique. 

Name  The name of the glass layer. If the record was imported from the Optics5 database, this 
name will automatically come from that database. 

Manufacturer  The name of the glass manufacturer. If the record was imported from the Optics5 
database, this name will autmoatically come from that database. 

Source Source of the optical data. Current options are: 

§ Optics: Indicates that the data was imported from the Optics5 database. These 
records will have the spectral data information from the Optics5 database. 
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§ User: Indicates that the data was created when the user copyied an existing record 
into a new record. User defined records will not have associated spectral data 
values. 

Mode An identifier to determine if the glass layer is approved by NFRC. Only records with 
“#” in this field can be used for NFRC simulations. 

Color A graphic representation of the color of the glass. 
Thickness  Glass thickness. Units: mm (SI); inches (IP). 

Tsol Solar transmittance of the glazing layer. 

Rsol1 Solar reflectance of the glazing layer, exterior-facing side. 
Rsol2 Solar reflectance of the glazing layer, interior-facing side. 

Tvis Visible transmittance of the glazing layer. 
Rvis1 Visible reflectance of the glazing layer, exterior-facing side. 

Rvis2 Visible reflectance of the glazing layer, interior-facing side. 
Tir Thermal infrared (longwave) transmittance of the glazing layer. 

emis1 Infrared (longwave) emittance of the glazing layer, exterior-facing side 

emis2 Infrared (longwave) emittance of the glazing layer, interior-facing side 
Cond Conductance of glass. Units: W/m-K (SI); Btu/h-ft-oF (IP) 
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4.5.2.  Glass Library List View 

The List View shows all the records in the Glass Library. 

 

Figure 4-20. Glass Library, List View. 

The buttons on the left hand side of the List View have the following functions: 
Detailed View goes to the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. 

Copy Used to copy an existing record (including name and all associated input values) into a 
new record. 

Delete Used to delete the highlighted record(s). 
Find Used to find a record based on the field selected from the pulldown list, and a value 

typed into the input box. 
Advanced  Used to access a more advanced method of searching the list 

Import  Used to import records from an Optics5 database, either the standard database or the 
user database. The database to be referenced can be specified in the File/Preferences 
menu, Optics 5  tab. 

Export Used to create a comma-separated text file of the library records, which can be imported 
into a spreadsheet or database program.  

Report Currently disabled. 
Print Used to print a report which contains a list of all the records in the library. 
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4.5.3.  The Optics5 Connection 

The WINDOW5 Glass Library is based on the Optics5 glass database, and is contains records from the most 
current Optics5 database available at the time of the program creation. The Source field indicates that the 
records are from the Optics5 program, and all these records are protected from editing (they have a gray 
background in the list view, and cannot be deleted or edited in the detailed view). All data that comes from 
the Optics5 database has detailed spectral data associated with it, equivalent to the "*" and "#" in WINDOW 
4.1. The optical properties displayed (transmittance, reflectance, emittance) are average values calculated 
from the Optics5 spectral data. 

As the Optics database is updated, the new records can be download from the following website and then 
imported into the WINDOW5 Glass Library: 

http://windows.lbl.gov/software 

4.5.4.  Updating the Glass Library from Optics5 

If a new version of the Optics5 database is released, these new records can be imported into the WINDOW5 
Glass Library using the Import button on the Glass Library list view. It is possible to import one or more 
records at a time, or all the records. 

To import Optics 5 records from the Optics5 database, follow these steps: 

§ In the File/Preferences menu, Optics 5  tab, use the Browse button to select the “Optics 5 database” or the 
“Optics 5 User database”, which will then be the default Optics 5 database that WINDOW will use for 
importing. 

Figure 4-21. Glass Library, List View. 

§ From the Glass Library List View, click on the Import  button 

§ The Select dialog box will show the records from the Optics 5 database. 

§ Highlight one or more records (Shift-left mouse click  to select multiple contiguous records, Ctrl-left 
mouse click  to select multiple non-contiguous records) 

§ Click on the Select button and the highlighted records will be imported into the WINDOW5 Glass 
Library. This may take a few minutes. If the records already exist, a dialog box will appear asking 
whether to overwrite existing records. The records will come in with the Source field set to Optics5, and 
they will be protected (not editable). 

§ OR, click on the Select All button and all the Optics5 records will be imported.  

Click on the Browse button to specify the 
Optics 5 database and/or Optics 5 User 
Database. Then click on the radio button 
to set the default database for WINDOW 
to use when the Import button is used 
from the Glass Library. 
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§ If the selected records already exist in the WINDOW5 Glass Library, the program will ask if you want to 
overwrite the existing records. These can be overwritten one at a time, or you can click on the "Yes to All" 
option, and all the records will be overwritten without any more warning messages. 

 

Figure 4-22. Importing records from the Optics5 database. 

Step 2: 
Highlight the reocrds to be imported into the 
Glass Library and click on the Select button 
to begin the import process. 
 
Or use the Select All button to import all the 
records from the Optics database. This import 
can take several minutes. 
 
Use Shift-left-mouse-click to select multiple 
contiguous records, and Ctrl-left-mouse-click 
to select multiple non-contiguous records. 

Step 1: 
Click on the Import 
button to open the 
Select dialog box, 
which shows the 
records in the Optics5 
database. 
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4.5.5.  Creating a User-Defined Glass Layer 

In most modeling situations, the Optics5 data provided in the WINDOW5 library (discussed in the previous 
sections) will be used for glass layer definitions because it contains detailed spectral data. However, it is 
possible to create a "user-defined" glass library record. This type of glass record will not be protected, will 
have the Source field set to "User", and will NOT have spectral data associated with it, and therefore 
WINDOW5 will only be able to do a single-band calculation. (Use the Optics5 program to make a new glass 
layer with spectral data and then import it into WINDOW5 with the method described above for importing 
data from the Optics5 database). In the case of a user-defined glass library created in WINDOW5, the values 
input for the optical properties will represent average data supplied by the user rather than calculated by 
WINDOW5 from the spectral data in the Optics5 database. 

To create a user-defined glass record in the Glass Library, follow these steps: 

§ In the Glass Library List View , copy an existing record by highlighting the record to be copied and 
clicking on the Copy button. This will create an unprotected record with Source set to "User", so that the 
fields can be changed in the Detailed View. 

§ Click on the Detailed View button to edit the glass information as needed, including the Name. 

§ Save the record using the Record/Save  menu (or Alt-S). 

 

Figure 4-23. Creating a user-defined glass layer which will not have spectral data associated with it. 

Step 2: 
Click on the 
Copy button to 
copy the 
highlighted 
record to a new 
record. 
Step 1: 
Highlight the 
record to be 
copied. 

Step 3: 
WINDOW5 will automatically assign a unique sequential ID for the new 
record. This ID can be changed as long as it is unique. Click the OK 
button to add the record. 
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Figure 4-24. The user defined glass layers must have the averaged optical properties input, rather than automatically calculated by the 
Optics5 spectral data files. 

After creating the record, the 
program will move to the new record 
and highlight it. 

Click on the 
Detailed View 
button. 

Edit the fields in the new record with the 
desired optical properties. 
 
Keep in mind that because this is a user 
defined record made in WINDOW5, it will 
not have the detailed spectal data that 
would be available from a layer created in 
the Optics5 program. 
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4.6.  Gas Library 

4.6.1.  Gas Library Detail View 

The Detail View shows details of individual gasses in the Gas Library. WINDOW5 is shipped with several 
“protected” gas records, but it is also possible to create user defined records. 

 

Figure 4-25. Gas Library, Detail View. 

The properties defined for each gas entry are listed below: 

ID Unique ID number associated with each gas record. The ID is automatically assigned 
when a record is added in the List View, but can be changed by the user at that time as 
long as the ID is unique.  

Name  Name of the gas record, input by the user. 

Conductivity Coefficients 
The conductivity calculation is based on the following formula from ISO 15099: 

 Cond=A + B*T + C*T2 
Where T = Temperature in degrees Kelvin 

WINDOW has input values for each of the coefficients in that formula: 
A Coefficient A for Conductivity from ISO 15099 

Units: W/m-K (SI); Btu/h-ft-oF (IP) 
B Coefficient B for Conductivity from ISO 15099 

Units: W/m-K2 (SI); Btu/h-ft-oF2 (IP) 



4.6.  Gas Library 4.  Program Description 

4-30 November 2001 WINDOW5 User Manual 

C Coefficient C for Conductivity from ISO 15099 
Units: W/m-K3 (SI); Btu/h-ft-oF3 (IP) 

Viscosity Coefficients 
The viscosity calculation is based on the following formula from ISO 15099: 

 Viscosity = A + B*T + C*T2 
Where T = Temperature in degrees Kelvin 

WINDOW has input values for each of the coefficients in that formula: 
A Coefficient A for Viscosity from ISO 15099 

Units:  g/m-s (SI); lb-s/ft2 (IP) 

B Coefficient B for Viscosity from ISO 15099 
Units:  g/m-s-K; (SI); lb-s/ft2-oF(IP) 

C Coefficient C for Viscosity from ISO 15099 
Units:  g/m-s-K2; (SI); lb-s/ft2-oF2(IP) 

Specific Heat Coefficients 
The specific heat calculation is based on the following formula from ISO 15099: 

 Specific Heat = A + B*T + C*T2 
Where T = Temperature in degrees Kelvin 

WINDOW has input values for each of the coefficients in that formula: 
A Coefficient A for Specific Heat from ISO 15099 

Units: Kj/kg-K (SI); Btu/lb-oF (IP) 
B Coefficient B for Specific Heat from ISO 15099 

Units: Kj/kg-K2 (SI); Btu/lb-oF2 (IP) 

C Coefficient C for Specific Heat from ISO 15099 
Units: Kj/kg-K3 (SI); Btu/lb-oF3 (IP) 

Molecular  
Weight Molecular weight of the gas.   
Properties at STP 
Gas properties at Standard Temperature and Pressure. 

Conductivity Conductivity of the gas, based on the Conductivity Coefficients and formula above. 
Units: W/m-K (SI); Btu/h-ft-oF (IP) 

Viscosity  Viscosity of the gas, based on the Viscosity Coefficients and formula above. Units: g/m-s 
(SI); lb-s/ft2 (IP) 

Specific Heat Specific heat of the gas, based on the Specific Heat Coefficients and formula above. 
Units: kJ/kg-K (SI); Btu/lb-oF (IP) 

Density  Density of the gas. Units: kg/m3 (SI); lb-ft3 (IP) 

Prandtl Prandtl number of the gas. Unitless. 

Property  
Calculator Property calculator for values at different pressures and temperatures other than the 

standard values. 
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It is also possible to define gas records in the Gas Library which are mixtures of other gases, as shown in the 
figure below. Section 4.6.3., “Gas Mixtures”, discusses how to creat new records composed of multiple gases. 

 

Figure 4-26. Gas Library, Detail View showing a gas mixture. 
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4.6.2.  Gas Library List View 

The List View shows all the records in the Gas Library. 

 

Figure 4-27. Gas Library, List View. 

 

The buttons on the left hand side of the List View have the following functions: 

Detailed View goes to the detailed view of the record, where the input values can be edited. 
New Used to make a new record, based on a default record. 

Copy Used to copy an existing record (including name and all associated input values) into a 
new record. 

Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 
Import Currently disabled. 

Export Used to create a comma-separated text file of library records, which can be imported 
into a spreadsheet or database program.  

Report Currently disabled. 

Print Used to print a report which contains a list of all the records in the library. 
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4.6.3.  Gas Mixtures 

To create a record that has a combination of gasses, follow these steps: 

§ Make a new record by using the Copy or New button (either a single gas record or a mixture). 

§ Double click on the newly created record, or highlight it and click on the Detailed View button, to access 
the Detailed View 

§ Click on the Mixture  checkbox if the gas is not already a mixture. 

§ Click on the Add button to add a new gas, then select the gas and type in the gas percentage in the Gas 
Mixture dialog box. A new line will appear in the gas mixtures section. 

§ Use the Add  and/or Delete  buttons create the desired gas mixture. 

Step 1: 
Make a new record 
using either the Copy 
button to copy an 
existing record or then 
New button to create 
a new record based 
on a default record. 

Step 2: 
Go to the Detailed 
View of the newly 
created record. 

Step 3: 
Change the 
name of the 
new record. 

Step 4: 
Click the Gas 
Mixture box so 
that a 
checkmark 
appears. 

Step 5: 
Click the Add 
Button, and the 
Gas Mixtures 
dialog box 
appears. 

Step 6: 
The Gas Mixture dialog box 
appears. Select the gas from the 
pulldown and type in the mixture 
percentage, then click the OK button. 

Step 7: 
A new line will appear with the added gas. 
Continue to add gases as necessary.  
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Figure 4-28. Creating a new gas that is a mixture. 

4.7.  Frame Library 

The Frame Library consists of frame elements (such as headers, jambs, sills, and meeting rails) and their 
associated frame and edge-of-glass properties for use in constructing a whole product in the Window 
Library .  

4.7.1.  Frame Library Detail View 

The Frame Library Detail View shows all the data for an individual record. 

 

Figure 4-29. Frame Library, Detail View. 

 

The properties defined for each gas entry are listed below: 

 

ID # The unique ID associated with this record. Default: WINDOW automatically assigns 
this number when creating a new record. When making a new record in the List View, it 
is possible to change the ID number as long as it is unique. 

Name  The name of the frame record. Default:  for imported THERM files, WINDOW 
automatically sets the name field to the name of the THERM file. In any case, this name 
is editable by the user. 

Source The source of the frame information, from the following list: 
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§ Generic:  The Generic choice is used when not importing a THERM file. When this 
selection is made, the Edge Correlation pulldown becomes enabled.  

§ ASHRAE/LBL:  The ASHRAE/LBNL choice is used for the five protected records 
that are shipped with WINDOW for consistency with previous versions of the 
program. They are based on the Edge Correlation methodology. 

§ THERM:   The THERM choice is automatically set by WINDOW when a THERM file 
is imported into the Frame Library from the List View. This setting will cause the 
Edge Correlation pulldown to become disabled. 

Filename  The THERM file filename, including the path. Type in the value or use the Browse 
button to select it. Default:  The complete filename of the THERM file if the Import 
button was used from the List View. 

Browse Button  Use the Browse button to select the THERM file associated with this Frame Library  
record. 

Type The type of cross section of the THERM file, based on the Cross Section Type value 
specified in the Properties dialog box (accessed from the File/Properties menu) in the 
THERM program. 

U-VALUES 

Frame U-factor of the frame, either imported from the THERM file or input by the user if 
source is “Generic”. 

Edge of Glass  U-factor of the edge of glass, either imported from the THERM file or input by the user 
if source is “Generic”. 

Edge Correlation Edge correlation for frames with Source set to either “Generic” or “ASHRAE/LBL”. 
Correlation choices are: 

 
Edge 
Correlation 
Number 

Spacer  
Material 

1 Aluminum – ASHRAE Metallic 
2 Stainless stell; dual seal 

3 Butyl/Metal (also Fiberglass, Wood, Glass Edge) 
4 Insulated 

5 U-edge = U-center-of-glass 
(Used when modeling single glazing) 

 

 
GLAZING SYSTEM 
Width Width of the glazing system, either from an imported THERM file or input by the user. 

Default: if the record is from an imported THERM file, this is the width of the glazing 
system from that file. 

Center of Glass  
U-value U-factor of the center-of-glass, either from an imported THERM file or input by the user. 

Default: if the record is from an imported THERM file, this is the U-factor of the glazing 
system from that file. 

FRAME 
Width Width of frame (projected frame dimension), which is the width of the fram element in 

the plane of the glazing. Default:  if the record is from an imported THERM file, the 
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width is the Frame Length which is displayed in the THERM U-factor dialog box when a 
file has results. 

Material Abs Absorptivity of the frame, editable by the user. This value does not come from the 
THERM file. Default: 0.500.  

Color Frame color, input by the user. This value does not come from the THERM file. Click on 
the color block and a Color dialog box will appear, where the desired color can be 
selected. 

Comment Comment about the frame, input by the user. Default: blank. 

Condenstation  
Index Condensation index of the frame components, if the record was imported from a 

THERM file. The Condensation Index values are: 

§ @30% RH, @50%RH, @70% RH:  the S components of the Condensation Index 
equation for each of the three relative humidity (RH) points in the NFRC 500: 
Procedure for Determining Fenestration Product Condensation Index  document for the 
Frame and Edge components of the THERM file. 

§ Overall:  the overall CI value calculated from the intermediate relative humidity 
values, for the Frame and Edge components of the THERM file, based on the 
formula in the the NFRC 500: Procedure for Determining Fenestration Product 
Condensation Index  document. 

 

 
Figure 4-30. Condensation Index details on Frame Library record. 
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4.7.2.  Frame Library list View 

The Frame Library List View shows all the records in the library. 

 

Figure 4-31. Frame Library, List View. 

The buttons on the left hand side of the List View have the following functions: 
Detailed View goes to the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. 
Copy Used to copy an existing record (including name and all associated input values) into a 

new record. 
Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 

Import  Used to import THERM files into the Frame Library.  
Export Used to create a comma-separated text file of library records, which can be imported 

into a spreadsheet or database program.  
Report Currently disabled. 

Print Used to print a report which contains a list of all the records in the library. 
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4.7.3.  Importing THERM files 

The THERM program is used to generate frame (and divider) profiles which can then be imported into the 
WINDOW5 Frame Library, and then referenced in the Window Library. 

There are two different methods for importing a THERM file into the Frame Library: 

§ From the Frame Library List View, use the Import button to select a THERM file. 

§ From the Frame Library Detail View, use the Browse button to select a THERM file to be associated with 
the current frame record. 

Figure 4-32. Use the Import button to create Frame Library records from THERM files. 

Step 1: 
Click on the 
Import button. 

Step 2: 
Select a THERM file 
from the Open 
dialog box. 

Step 4: 
WINDOW will create a new record, with the Name field set to the THERM filename. 

Step 3: 
WINDOW will automatically assign an ID 
for the new record (or you can type in 
the ID, as long as the number is unique).
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In order to make change to the newly imported THERM file, click on the Detailed View button and change 
the input values as needed. 

Note:  In order for the CI (Condensation Index) values to be imported from the THERM file into the WINDOW Frame 
Library, it is necessary to check the “Save Simulation Results in THM files” in the THERM program under the 
Options/Preferences menu, the Simulation tab. 

Figure 4-33. Edit the THERM file frame record if neccessary. 

Step 6: 
Edit the Name, Material Abs or Color fields, 
or reference another THERM file if 
necessary using the Browse button. 
 
WINDOW keeps the paths for the THERM 
fiels, so the files must be in these locations 
for the calculations to use the THERM data. 
Rebrowse to a file if it has been moved to a 
different directory on your computer. 

Step 5: 
To edit the newly created Frame Library 
record, highlight the record and either 
double click, or click on the Detailed View 
button. 
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4.7.4.  Condensation Index (CI) Calculation 

WINDOW5 includes a feature which calculates the whole product Condensation Index (CI) using the 
methodology presented in NFRC 500.  This process involves importing surface temperatures from THERM 
for each frame cross-section. When performing CI calculations with this Beta1 version of WINDOW5, note the 
following: 

§ It is necessary to use THERM5 in order to get  the proper temperature data. Older versions of THERM 
will not have the correct data. 

§ The THERM modeling procedures are outlined in the THERM5 / WINDOW5 NFRC Simulation Manual. As 
discussed in that manual, it is necessary to model the THERM profiles with the CI feature turned on 
(when importing the glazing system, or after the glazing system is imported in the Options/Preferences 
menu, Therm File Options tab). Modeling THERM profiles with the CI feature NOT turned on will result 
in U-factors that are not calculated in accordance with standard NFRC procedures. Therefore, it is 
necessary to do two THERM calculations (and save them to two separate files): 

§ one for U-factor values with CI turned off 

§ one for CI with CI turned on. 

The CI values from the THERM files are shown in WINDOW in the Condensation Index section of the Frame 
Library Detailed View, as discussed in Section 4.7.1 , “Frame Library Detail View”.  
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4.8.  Divider Library 
The Divider Library is very similar to the Frame Library. The Divider Library has frame and edge-of-glass 
properties, which can be input by the user or imported from THERM files, for use in constructing a whole 
product in the Window Library .  

 

4.8.1.  Divider Library Detail View 

The Detail View shows details of individual dividers in the Divider Library  

 

Figure 4-34. Divider Library, Detail View. 

The properties defined for each gas entry are listed below: 

 
ID # The unique ID associated with this record. Default: WINDOW automatically assigns 

this number when creating a new record. When making a new record in the List View, 
it is possible to change the ID number as long as it is unique. 

Name  The name of the divider record. Default: for imported THERM files, WINDOW 
automatically sets the name field to the name of the THERM file. In any case, this name 
is editable by the user. 

Source The source of the divider information, from the following list: 
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§ Generic:  The Generic choice is used when not importing a THERM file. When this 
selection is made, the Edge Correlation pulldown becomes enabled.  

§ ASHRAE/LBL:  The ASHRAE/LBNL choice is used for the protected records that 
are shipped with WINDOW for consistency with previous versions of the program. 
They are based on the Edge Correlation methodology. 

§ THERM:   The THERM choice is automatically set by WINDOW when a THERM file 
is imported into the Divider Library from the List View. This setting will cause the 
Edge Correlation pulldown to become disabled. 

Filename  The THERM file filename, including the path. Type in the value or use the Browse 
button to select it. Default:  The complete filename of the THERM file if the Import 
button was used from the List View. 

Browse Button  Use the Browse button to select the THERM file associated with this Divider Library 
record. 

Type The type of cross section of the THERM file, based on the Cross Section Type value 
specified in the Properties dialog box (accessed from the File/Properties menu) in the 
THERM program, from the following list: 

§ Divided:  for “true” divided lite dividers 

§ Suspended:  for dividers suspended between the glass layers of the glazing system 
U-VALUES 
Frame U-factor of the divider, either imported from the THERM file or input by the user if 

source is “Generic”. 
Edge of Glass  U-factor of the edge of glass, either imported from the THERM file or input by the user 

if source is “Generic”. 
Edge Correlation Edge correlation for dividers with Source set to either “Generic” or “ASHRAE/LBL”. 

Correlation choices are: 
 

Edge Correlation Number Spacer Material 

 Divided Lights: 
1 Aluminum, hollow 

2 Butyl, solid, with aluminum backing 
3 Wood, solid 

4 Insulating material, solid (k=0.012 Btu/hr-ft-oF 
 Divided Lights: 

5 Aluminum, hollow 

6 Vinyl, hollow 
 

 
GLAZING SYSTEM 
Width Width of the glazing system, either from an imported THERM file or input by the user. 

Default: if the record is from an imported THERM file, this is the width of the glazing 
system from that file. 

Center of Glass  
U-value U-factor of the center-of-glass, either from an imported THERM file or input by the user. 

Default: if the record is from an imported THERM file, this is the U-factor of the glazing 
system from that file. 
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FRAME 
Width Width of divider (projected dimension), which is the width of the divider element in the 

plane of the glazing. Default:  if the record is from an imported THERM file, the width is 
the Frame Length which is displayed in the THERM U-factor dialog box when a file has 
results. 

Material Abs Absorptivity of the divider, editable by the user. This value does not come from the 
THERM file. Default: 0.500.  

Color Frame color, input by the user. This value does not come from the THERM file. Click on 
the color block and a Color dialog box will appear, where the desired color can be 
selected. 

Comment Comment about the divider, input by the user. Default: blank. 

Condenstation  
Index Condensation index of the divider components, if the record was imported from a 

THERM file. The Condensation Index values are: 

§ @30% RH, @50%RH, @70% RH:  the S components of the Condensation Index 
equation for each of the three relative humidity (RH) points in the NFRC 500: 
Procedure for Determining Fenestration Product Condensation Index  document for the 
Frame and Edge components of the THERM file. 

§ Overall:   the overall CI value calculated from the intermediate relative humidity 
values, for the Frame and Edge components of the THERM file, based on the 
formula in the the NFRC 500: Procedure for Determining Fenestration Product 
Condensation Index  document. 

 

 
Figure 4-35. Condensation Index details on Frame Library record. 
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4.8.2.  Divider Library List View 

The List View shows all the records in the Divider Library. 

 

Figure 4-36. Divider Library, List View. 

The buttons on the left hand side of the List View have the following functions: 
Detailed View goes to the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. 
Copy Used to copy an existing record (including name and all associated input values) into a 

new record. 
Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 

Import  Used to import THERM files into the Divider Library.  
Export Used to create a comma-separated text file of library records, which can be imported 

into a spreadsheet or database program.  
Report Currently disabled. 

Print Used to print a report which contains a list of all the records in the library. 
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4.8.3.  Importing THERM Files 

The technique for importing THERM files into the Divider Library is the same as for the Frame Library (see 
Section 4.7.3 , "Importing THERM Files"). 

There are two different methods for importing a THERM file into the Divider Library: 

§ From the Divider Library List View, use the Import button to select a THERM file. 

§ From the Divider Library Detail View, use the Browse button to select a THERM file to be associated with 
the current frame record. 
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4.9.  Environmental Conditions Library 
The Environmental Conditions Library contains sets of environmental conditions for the U-factor and Solar 
Heat Gain Coefficient (SHGC) calculations. U-factor environmental conditions are typically defined for 
winter, night-time conditions while solar heat gain environmental conditions are defined for summer, 
daytime conditions. 

4.9.1.  Environmental Conditions Library Detail View 

The Detail View shows details of individual environmental condition records in the Environmental 
Conditions Library. One environmental condition record consists of definitions for all four tabs in the 
detailed view, which consists of two tabs for U-factor (Inside and Outside) and two tabs for SHGC (Inside 
and Outside). 
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U-factor Inside tab 

The U-factor Inside tab of the Environmental Conditions library is used to define the conditions for the U-
factor calculations for the inside surface of the window. 

 

Figure 4-37. Environmental Conditions Library, Detail View, U-factor Inside Tab. 
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The input values are the following: 

Inside Air  
Temperature Inside air temperature. Units: oC (SI); oF (IP) 
Convection 
Model The convection model, which controls what other input values appear in this section, 

from the following choices: 

Model Convection Coeff Outside Wind Speed Wind Direction 

ASHRAE/NFRC Outside User Input User input Choices: 

Windward 
Leeward 

ASHRAE/NFRC Inside N/A N/A N/A 

Fixed Convection Coefficient User Input N/A N/A 

Fixed Combined Coefficient User Input N/A N/A 

Yazdanian-Klems N/A N/A N/A 

Kimura User Input User input Choices: 

Windward 

Leeward 

 
Radiation 
Model The radiation model, which controls what other input values appear in this section: 

 

Model Effective Room Temperature Effective Room Emissivity 

ASHRAE/NFRC Outside User Input User input 

ASHRAE/NFRC Inside User Input User input 

Fixed Convection Coefficient User Input User input 

Fixed Combined Coefficient N/A N/A 

Yazdanian-Klems User Input User input 

Kimura User Input User input 
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U-factor Outside tab 

The U-factor Inside tab of the Environmental Conditions library is used to define the conditions for the U-
factor calculations for the outside surface of the window. 

 

Figure 4-38. Environmental Conditions Library, Detail View, U-factor Outside Tab. 
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The input values are the following: 

Outside Air  
Temperature Outside air temperature. Units: oC (SI); oF (IP) 
Convection 
Model The convection model, which controls what other input values appear in this section: 

 

Model Convection Coeff Outside Wind Speed Wind Direction 

ASHRAE/NFRC Outside User Input User input Choices: 

Windward 
Leeward 

ASHRAE/NFRC Inside N/A N/A N/A 

Fixed Convection Coefficient User Input N/A N/A 

Fixed Combined Coefficient User Input N/A N/A 

Yazdanian-Klems N/A N/A N/A 

Kimura User Input User input Choices: 

Windward 

Leeward 

 
Radiation 
Model The radiation model, which controls what other input values appear in this section: 

 

Model Effective Sky Temperature Effective Sky Emissivity 

ASHRAE/NFRC Outside User Input User input 

ASHRAE/NFRC Inside User Input User input 

Fixed Convection Coefficient User Input User input 

Fixed Combined Coefficient N/A N/A 

Yazdanian-Klems User Input User input 

Kimura User Input User input 
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SHGC Inside tab 

The SHGC (Solar Heat Gain Coefficient) Inside tab of the Environmental Conditions library is used to define 
the conditions for the SHGC calculations for the inside surface of the window. 

 

Figure 4-39. Environmental Conditions Library, Detail View, Solar Heat Gain Coefficient Inside tab. 

The input values are the following: 
Inside Air  
Temperature Inside air temperature. Units: oC (SI); oF (IP) 
Convection 

Model The convection model, which controls what other input values appear in this section, 
from the following choices: 

Model Convection Coeff Inside Air Velocity Air Direction 
ASHRAE/NFRC Outside User Input User input Choices: 

Windward 

Leeward 

ASHRAE/NFRC Inside N/A N/A N/A 

Fixed Convection Coefficient User Input N/A N/A 

Fixed Combined Coefficient User Input N/A N/A 

Yazdanian-Klems N/A N/A N/A 

Kimura User Input User input Choices: 
Windward 

Leeward 
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Radiation 
Model The radiation model, which controls what other input values appear in this section: 

 

Model Effective Room Temperature Effective Room Emissivity 

ASHRAE/NFRC Outside User Input User input 

ASHRAE/NFRC Inside User Input User input 

Fixed Convection Coefficient User Input User input 

Fixed Combined Coefficient N/A N/A 

Yazdanian-Klems User Input User input 

Kimura User Input User input 
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SHGC Outside tab 

The SHGC (Solar Heat Gain Coefficient) Inside tab of the Environmental Conditions library is used to define 
the conditions for the SHGC calculations for the inside surface of the window. 

 

Figure 4-40. Environmental Conditions Library, Detail View, Solar Heat Gain Coefficient Outside tab. 

The input values are the following: 

Outside Air  
Temperature Inside air temperature. Units: oC (SI); oF (IP) 
Direct Solar 
Radiation Direct solar radiation. Units: W/m2 (SI); Btu/ft2 (IP) 
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Convection 
Model The convection model, which controls what other input values appear in this section, 

from the following choices: 

Model Convection Coeff Inside Air Velocity Air Direction 

ASHRAE/NFRC Outside User Input User input Choices: 

Windward 
Leeward 

ASHRAE/NFRC Inside N/A N/A N/A 

Fixed Convection Coefficient User Input N/A N/A 

Fixed Combined Coefficient User Input N/A N/A 

Yazdanian-Klems N/A N/A N/A 

Kimura User Input User input Choices: 

Windward 
Leeward 

 
Radiation 
Model The radiation model, which controls what other input values appear in this section: 

 

Model Effective Sky Temperature Effective Sky Emissivity 
ASHRAE/NFRC Outside User Input User input 

ASHRAE/NFRC Inside User Input User input 

Fixed Convection Coefficient User Input User input 

Fixed Combined Coefficient N/A N/A 

Yazdanian-Klems User Input User input 

Kimura User Input User input 
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4.9.2.  Environmental Conditions Library List View 

The List View shows all the records in the Environmental Conditions Library.There are three pre-defined, 
protected records provided, and it is possible to copy these records and create other (unprotected) records 
with any conditions that need to be defined. 

 

Figure 4-41. Environmental Conditions Library, Detail View, Solar Heat Gain Coefficient Outside tab. 

The buttons on the left hand side of the List View have the following functions: 
Detailed View goes to the detailed view of the record, where the input values can be edited. 

New Used to make a new record, based on a default record. 
Copy Used to copy an existing record (including name and all associated input values) into a 

new record. 
Delete Used to delete the highlighted record(s). 

Find Used to find a record based on the field selected from the pulldown list, and a value 
typed into the input box. 

Advanced  Used to access a more advanced method of searching the list 

Import  Currently disabled. 
Export Used to create a comma-separated text file of library records, which can be imported 

into a spreadsheet or database program.  
Report Currently disabled. 

Print Used to print a report which contains a list of all the records in the library. 
 

 



 


